482

22. Sale Prices for Houses The average sales price of new
one-family houses in the Midwest is $250,000 and in
the South is $253,400. A random sample of 40 houses
in each region was examined with the following results.
At the 0.05 level of significance can it be concluded
that the difference in mean sales price for the two

Chapter 9 Testing the Difference Between Two Means, Two Proportions, and Two Variances

23. Average Earnings for College Graduates The aver-

age earnings of year-round full-time workers with bach-
elor’s degrees or more is $88,641 for men and $58,000
for women—a difference of slightly over $30,000 a
year. One hundred of each were sampled, resulting in a
sample mean of $90,200 for men, and the population

regions is greater than $3400? standard deviation is $15,000, and a mean of $57,800

for women, and the population standard deviation is
$12,800. At the 0.01 level of significance can it be
concluded that the difference in means is not $30,000?

Source: New York Times Almanac.

South Midwest

Sample size 40 40
Sample mean 261,500 248,200
Population standard deviation 10,500 12,000

Source: New York Times Almanac.

Step by Step

TI-83 P|us or Hypothesis Test for the Difference Between Two Means
and z Distribution (Data)
TI-84 Plus |

Step by Step

. Enter the data values into L, and L,,.

. Press STAT and move the cursor to TESTS.

. Press 3 for 2-SampZTest.

Move the cursor to Data and press ENTER.

. Type in the appropriate values.

. Move the cursor to the appropriate alternative hypothesis and press ENTER.
. Move the cursor to Calculate and press ENTER.

N R W

Hypothesis Test for the Difference Between Two Means
and z Distribution (Statistics)

1. Press STAT and move the cursor to TESTS.

. Press 3 for 2-SampZTest.

. Move the cursor to Stats and press ENTER.

. Type in the appropriate values.

. Move the cursor to the appropriate alternative hypothesis and press ENTER.
. Move the cursor to Calculate and press ENTER.

A N A W N

Confidence Interval for the Difference Between Two Means
and z Distribution (Data)
1. Enter the data values into L; and L.
. Press STAT and move the cursor to TESTS.
. Press 9 for 2-SampZint.
. Move the cursor to Data and press ENTER.
. Type in the appropriate values.
. Move the cursor to Calculate and press ENTER.

A N A W N

Confidence Interval for the Difference Between Two Means
and z Distribution (Statistics)

1. Press STAT and move the cursor to TESTS.

. Press 9 for 2-SampZint.

. Move the cursor to Stats and press ENTER.

. Type in the appropriate values.

. Move the cursor to Calculate and press ENTER.

N A W
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Excel
Step by Step

Two-Sample z Test
Dialog Box

Z Test for the Difference Between Two Means
Excel has a two-sample z test included in the Data Analysis Add-in. To perform a z test for the
difference between the means of two populations, given two independent samples, do this:

1. Enter the first sample data set into column A.

2. Enter the second sample data set into column B.

3. If the population variances are not known but # = 30 for both samples, use the formulas
=VAR(A1:An) and =VAR(B1:Bn), where An and Bn are the last cells with data in each
column, to find the variances of the sample data sets.

4. Select the Data tab from the toolbar. Then select Data Analysis.
5. In the Analysis Tools box, select z test: Two sample for Means.

6. Type the ranges for the data in columns A and B and type a value (usually 0) for the
Hypothesized Mean Difference.

7. If the population variances are known, type them for Variable 1 and Variable 2. Otherwise,
use the sample variances obtained in step 3.

8. Specify the confidence level Alpha.
9. Specify a location for the output, and click [OK].

Example XL9-1
Test the claim that the two population means are equal, using the sample data provided
L here, at o = 0.05. Assume the population variances are o3 = 10.067 and o3 = 7.067.
SetA | 10 2 15 18 13 15 16 14 18 12 15 15 14 18 16
SetB | 5 8 10 9 9 11 12 16 8 8 9 10 11 7 6

The two-sample z test dialog box is shown (before the variances are entered); the results
appear in the table that Excel generates. Note that the P-value and critical z value are
provided for both the one-tailed test and the two-tailed test. The P-values here are expressed
in scientific notation: 7.09045E-06 = 7.09045 X 107% = 0.00000709045. Because this value
is less than 0.05, we reject the null hypothesis and conclude that the population means are
not equal.

i z-Test Two Sample for Means

9-13
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z-Test: Two Sample for Means

Variable 1 Variable 2
Mean 14.06666667 9.266666667
Known Variance 10.067 7.067
Observations 15 15
Hypothesized Mean Difference 0
4 4,491149228
P(Z<=z) one-tail 3.54522E-06
z Critical one-tail 1.644853
P(Z<=2z) two-tail 7.09045E-06
z Critical two-tail 1.959961082

m Testing the Difference Between Two Means

Objective [E}}
Test the difference
between two means
for independent
samples, using the
t test.

9-14

of Independent Samples: Using the f Test

In Section 9—1, the z test was used to test the difference between two means when the pop-
ulation standard deviations were known and the variables were normally or approximately
normally distributed, or when both sample sizes were greater than or equal to 30. In many
situations, however, these conditions cannot be met—that is, the population standard devi-
ations are not known. In these cases, a ¢ test is used to test the difference between means
when the two samples are independent and when the samples are taken from two normally
or approximately normally distributed populations. Samples are independent samples
when they are not related. Also it will be assumed that the variances are not equal.

Formula for the t Test—For Testing the Difference
Between Two Means—Independent Samples

Variances are assumed to be unequal

(Xl _Xz) - (Ml - Mz)

2
i, 5

ny n

where the degrees of freedom are equal to the smaller of n, — 1 orn, — 1.

The formula

2 2
) S
2l 22

ny
follows the format of

(observed value) — (expected value)
standard error

Test value =

where X, — X, is the observed difference between sample means and where the
expected value u, — u, is equal to zero when no difference between population means is
hypothesized. The denominator \/s?/n; + s3/n, is the standard error of the difference
between two means. Since mathematical derivation of the standard error is somewhat
complicated, it will be omitted here.
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Assumptions for the  Test for Two Independent Means When o, and o,

Are Unknown

1. The samples are random samples.
2. The sample data are independent of one another.

3. When the sample sizes are less than 30, the populations must be normally or
approximately normally distributed.

Example 9-4

Critical and Test Values
for Example 9-4

Farm Sizes

The average size of a farm in Indiana County, Pennsylvania, is 191 acres. The average size
of a farm in Greene County, Pennsylvania, is 199 acres. Assume the data were obtained
from two samples with standard deviations of 38 and 12 acres, respectively, and sample
sizes of 8 and 10, respectively. Can it be concluded at & = 0.05 that the average size of the
farms in the two counties is different? Assume the populations are normally distributed.

Source: Pittsburgh Tribune-Review.

Solution

Step 1 State the hypotheses and identify the claim for the means.
Hy: oy =y and H: pu, # u, (claim)

Step 2 Find the critical values. Since the test is two-tailed, since & = 0.05, and since
the variances are unequal, the degrees of freedom are the smaller of n, — 1

or n, — 1. In this case, the degrees of freedom are 8§ — 1 = 7. Hence, from
Table F, the critical values are +2.365 and —2.365.

Step 3 Compute the test value. Since the variances are unequal, use the first formula.

oK) ) (191219920,

J_+_ 3 12
n, n 8 10

Step 4 Make the decision. Do not reject the null hypothesis, since —0.57 > —2.365.
See Figure 9-5.

| |
-2.365 -057 0 +2.365

Step 5 Summarize the results. There is not enough evidence to support the claim that
the average size of the farms is different.

When raw data are given in the exercises, use your calculator or the formulas in
Chapter 3 to find the means and variances for the data sets. Then follow the procedures
shown in this section to test the hypotheses.

9-15
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Confidence intervals can also be found for the difference between two means with
this formula:

Confidence Intervals for the Difference of Two Means:

Independent Samples

Variances assumed to be unequal:

s o st 83 v _ o st 83
(X1 = X)) = tyor [ + =<y — po < (X = Xo) + oy [— + =
ny Ny ny n

d.f. = smaller value of n, — 1 orn, — 1

Example 9-5 Find the 95% confidence interval for the data in Example 9-4.

Solution

Substitute in the formula.

5 _ st 5
X; = X)) = topy /= + = <py — o
n. nm

2 2
(191 — 199) — 2.365 % + % < — 1

382 122
< - + 2365\ —+—
(191 — 199) + 2.365 g 0
—41.02 <, — py, <25.02

Since 0 is contained in the interval, the decision is to not reject the null hypothesis
Hy: gy = o

In many statistical software packages, a different method is used to compute the
degrees of freedom for this # test. They are determined by the formula

(S%/nl + S%/”z)z

/Py = 1)+ (3/n)*/(m, — 1)

This formula will not be used in this textbook.

There are actually two different options for the use of 7 tests. One option is used when
the variances of the populations are not equal, and the other option is used when the vari-
ances are equal. To determine whether two sample variances are equal, the researcher
can use an F test, as shown in Section 9-5.

When the variances are assumed to be equal, this formula is used and

()_(1 - )_(2) — (1 — o)
\/(nl —Ds$+m,—Ds3 [T 1

d.f.

nl + n2 - 2 nl n2
follows the format of

(observed value) — (expected value)
standard error

Test value =

For the numerator, the terms are the same as in the previously given formula. However,
a note of explanation is needed for the denominator of the second test statistic. Since both

9-16
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populations are assumed to have the same variance, the standard error is computed with
what is called a pooled estimate of the variance. A pooled estimate of the variance is
a weighted average of the variance using the two sample variances and the degrees of
freedom of each variance as the weights. Again, since the algebraic derivation of the
standard error is somewhat complicated, it is omitted.

Note, however, that not all statisticians are in agreement about using the F test before
using the 7 test. Some believe that conducting the F and ¢ tests at the same level of signifi-
cance will change the overall level of significance of the ¢ test. Their reasons are beyond
the scope of this textbook. Because of this, we will assume that o, # o, in this textbook.

Applying the Concepts 9=2

Too Long on the Telephone

A company collects data on the lengths of telephone calls made by employees in two different
divisions. The mean and standard deviation for the sales division are 10.26 and 8.56, respectively.
The mean and standard deviation for the shipping and receiving division are 6.93 and 4.93,
respectively. A hypothesis test was run, and the computer output follows.

Degrees of freedom = 56

Confidence interval limits = —0.18979, 6.84979
Test statistic = 1.89566

Critical value = —2.0037, 2.0037

P-value = 0.06317

Significance level = 0.05

1. Are the samples independent or dependent?

2. Which number from the output is compared to the significance level to check if the null
hypothesis should be rejected?

3. Which number from the output gives the probability of a type I error that is calculated
from the sample data?

4. Was a right-, left-, or two-tailed test done? Why?
5. What are your conclusions?
6. What would your conclusions be if the level of significance were initially set at 0.10?

See page 531 for the answers.

Exercises 9-2 H

For these exercises, perform each of these steps. Assume bestseller list is 22 weeks. The standard deviation is
that all variables are normally or approximately 6.17 weeks. The mean for the number of weeks 15 New
normally distributed. York Times hard-cover nonfiction books spent on the list
a. State the hypotheses and identify the claim. is 28 weeks. The standard deviation is_13.2 _weeks. At.
b. Find the critical value(s). a = 0.10, can we conclude that there is a difference in
c. Compute the test value. the mean times fo.r the number of weeks the books were
d Make the decision. on the bestseller lists?
e.  Summarize the results. 2. Tax-Exempt Properties A tax collector wishes to see

Use the traditional method of hypothesis testing unless
otherwise specified.
For these exercises assume the variances are unequal.

if the mean values of the tax-exempt properties are
different for two cities. The values of the tax-exempt
properties for the two samples are shown. The data are
given in millions of dollars. A a = 0.05, is there enough

1. Bestseller Books The mean for the number of weeks 15 evidence to support the tax collector’s claim that the
New York Times hard-cover fiction books spent on the means are different?
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City A | City B
113 22 14 8 82 11 5 15
25 23 23 30 295 50 12 9
4 11 19 7 12 68 81 2
31 19 5 2 20 16 4 5

. Noise Levels in Hospitals The mean noise level of
20 areas designated as “casualty doors” was 63.1 dBA,
and the standard deviation is 4.1 dBA. The mean noise
level for 24 areas designated as operating theaters was
56.3 dBA, and the standard deviation was 7.5 dBA. At
a = 0.05, can it be concluded that there is a difference
in the means?

. Ages of Gamblers The mean age of a sample of

25 people who were playing the slot machines is

48.7 years, and the standard deviation is 6.8 years. The
mean age of a sample of 35 people who were playing
roulette is 55.3 with a standard deviation of 3.2 years.
Can it be concluded at @ = 0.05 that the mean age of
those playing the slot machines is less than those
playing roulette?

. Carbohydrates in Candies The number of grams of
carbohydrates contained in 1-ounce servings of
randomly selected chocolate and nonchocolate candy
is listed here. Is there sufficient evidence to conclude
that the difference in the means is significant? Use

a = 0.10.

Chocolate: 29 25 17 36 41 25 32 29
38 34 24 27 29

Nonchocolate: 41 41 37 29 30 38 39 10
29 55 29

Source: The Doctor’s Pocket Calorie, Fat, and Carbohydrate Counter.

r 6. Teacher Salaries A researcher claims that the mean

of the salaries of elementary school teachers is greater
than the mean of the salaries of secondary school
teachers in a large school district. The mean of the
salaries of a sample of 26 elementary school teachers is
$48,256, and the sample standard deviation is $3,912.40.
The mean of the salaries of a sample of 24 secondary
school teachers is $45,633. The standard deviation is
$5,533. At = 0.05, can it be concluded that the mean
of the salaries of the elementary school teachers is
greater than the mean of the salaries of the secondary
school teachers? Use the P-value method.

. Weights of Running Shoes The weights in ounces of a
sample of running shoes for men and women are shown.
Test the claim that the means are different. Use the
P-value method with & = 0.05.

Men | Women
104 12.6 10.6 10.2 8.8
11.1 14.7 9.6 9.5 9.5
10.8 12.9 10.1 11.2 9.3
11.7 13.3 9.4 10.3 9.5
12.8 14.5 9.8 10.3 11.0

9-18
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8. Weights of Vacuum Cleaners Upright vacuum

cleaners have either a hard body type or a soft body
type. Shown are the weights in pounds of a sample of
each type. At @ = 0.05, can it be concluded that the
means of the weights are different?

Hard body types | Soft body types
21 17 17 20 24 13 11 13
16 17 15 20 12 15

23 16 17 17
13 15 16 18
18

4 9. Find the 95% confidence interval for the difference

of the means in Exercise 3 of this section.
3.066 < 1, — p, < 10.534

10. Find the 95% confidence interval for the difference of

11.

12.

the means in Exercise 8 of this section.
—2.481 <, — w, <7.971

Hours Spent Watching Television According to
Nielsen Media Research, children (ages 2—11) spend an
average of 21 hours 30 minutes watching television per
week while teens (ages 12—17) spend an average of

20 hours 40 minutes. Based on the sample statistics
obtained below, is there sufficient evidence to conclude
a difference in average television watching times
between the two groups? Use @ = 0.01.

Children Teens
Sample mean 22.45 18.50
Sample variance 16.4 18.2
Sample size 15 15

Source: Time Almanac.

NFL Salaries An agent claims that there is no differ-
ence between the pay of safeties and linebackers in the
NFL. A survey of 15 safeties found an average salary
of $501,580, and a survey of 15 linebackers found an
average salary of $513,360. If the standard deviation in
the first sample is $20,000 and the standard deviation in
the second sample is $18,000, is the agent correct? Use
a = 0.05.

Source: NFL Players Assn./USA TODAY.

13. Cyber School Enrollment The data show the
number of students attending cyber charter schools in
Allegheny County and the number of students attending

cyber schools in counties surrounding Allegheny
County. At @ = 0.01 is there enough evidence

to support the claim that the average number of students
in school districts in Allegheny County who attend
cyber schools is greater than those who attend cyber
schools in school districts outside Allegheny County?
Give a factor that should be considered in interpreting
this answer.

Allegheny County | Outside Allegheny County

25

75 38 41 27 32 |57 25 38 14 10 29

Source: Pittsburgh Tribune-Review.
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14. Ages of Homes Whiting, Indiana, leads the “Top

100 Cities with the Oldest Houses” list with the average
age of houses being 66.4 years. Farther down the list
resides Franklin, Pennsylvania, with an average house
age of 59.4 years. Researchers selected a random
sample of 20 houses in each city and obtained the
following statistics. At « = 0.05, can it be concluded
that the houses in Whiting are older? Use the P-value
method.

Whiting Franklin
Mean age 62.1 years 55.6 years
Standard deviation 5.4 years 3.9 years

Source: www.city-data.com

15. Hospital Stays for Maternity Patients Health Care
Knowledge Systems reported that an insured woman
spends on average 2.3 days in the hospital for a routine
childbirth, while an uninsured woman spends on
average 1.9 days. Assume two samples of 16 women
each were used in both samples. The standard deviation
of the first sample is equal to 0.6 day, and the standard
deviation of the second sample is 0.3 day. At « = 0.01,
test the claim that the means are equal. Find the 99%
confidence interval for the differences of the means.
Use the P-value method.

Source: Michacl D. Shook and Robert L. Shook, The Book of Odds.

16. Hockey’s Highest Scorers The number of points

held by a sample of the NHL’s highest scorers for both
the Eastern Conference and the Western Conference is
shown below. At @ = 0.05, can it be concluded that there
is a difference in means based on these data?

Eastern Conference | Western Conference

83 60 75 58 77 59 72 58
78 59 70 58 37 57 66 55
62 61 59 61

Source: www.foxsports.com

17. Medical School Enrollments A random sample

of enrollments from medical schools that specialize in
research and from those that are noted for primary care
is listed. Find the 90% confidence interval for the
difference in the means. 9.87 < u, — p, < 219.6

Research |

474 577 605 663 783 605 427 728
783 467 670 414 546 474 371 107
813 443 565 696 442 587 293 277
692 694 277 419 662 555 527 320
884

Source: U.S. News & World Report Best Graduate Schools.

Primary care

18. Out-of-State Tuitions The out-of-state tuitions
(in dollars) for random samples of both public and
private four-year colleges in a New England state are
listed. Find the 95% confidence interval for the

difference in the means.

Private | Public
13,600 13,495 7,050 9,000
16,590 17,300 6,450 9,758
23,400 12,500 7,050 7,871

16,100

Source: New York Times Almanac. $1789.70 < u, — u, < $12,425.41

Step by Step

MINITAB
Step by Step

for women?

There is one sample in each column.
4. Click in the box for First:. Double-click C1 MaleS in the list.

Test the Difference Between Two Means: Independent Samples*

MINITAB will calculate the test statistic and P-value for differences between the means for
two populations when the population standard deviations are unknown.
For Example 9-2, is the average number of sports for men higher than the average number

1. Enter the data for Example 9-2 into C1 and C2. Name the columns MaleS and FemaleS.
2. Select Stat>Basic Statistics>2-Sample t.

3. Click the button for Samples in different columns.

*MINITAB does not calculate a z test statistic. This statistic can be used instead.
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5. Click in the box for Second:, then 2-Sample t (Test and Confidence Interval) fl
double-click C2 FemaleS in the list. ¢ Eamplealione coldmn |
Do not check the box for Assume el
equal variances. MINITAB will ) i
use the large sample formula. & f:"f't""” 1 '"::'S" AL
The completed dialog box is shown. ot e ——

6. Click [OpthnS] r sulﬂlllﬂlil.ﬂl dala §i
a) Type in 90 for the Confidence o — r

level and 0 for the Test mean. PAERMAL I I
b) Select greater than for the I [ssume equal variance
Alternative. This option affects 2-Sample t - Options __; A

the P-value. It must be correct. Confidence level: [30

:j Cancel

7. Click [OK] twice. Since the P-value Testditterence:  [5.0
is greater than the significance level,
0.172 > 0.1, do not reject the null
hypothesis. Help | [ ok, | Concel |

]

Alternative:  [greater than =

Two-Sample t-Test and CI: MaleS, FemaleS
Two-sample t for MaleS vs FemaleS
N Mean StDev SE Mean

MaleSs 50 8.56 3.26 0.46
FemaleS 50 7.94 3.27 0.46
Difference = mu (MaleS) - mu (FemaleS)

Estimate for difference: 0.620000
90% lower bound for difference: -0.221962
t-Test of difference = 0 (vs >): t-Value = 0.95 P-Value = 0.172 DF = 97

TI-83 Plus or

TI-84 Plus
Step by Step

9-20

Hypothesis Test for the Difference Between
Two Means and # Distribution (Statistics)
1. Press STAT and move the cursor to TESTS.
. Press 4 for 2-SampTTest.
. Move the cursor to Stats and press ENTER.
. Type in the appropriate values.
. Move the cursor to the appropriate alternative hypothesis and press ENTER.

. On the line for Pooled, move the cursor to No (standard deviations are assumed not equal)
and press ENTER.

7. Move the cursor to Calculate and press ENTER.

A N A W N

Confidence Interval for the Difference Between
Two Means and f Distribution (Data)
1. Enter the data values into L, and L,.
. Press STAT and move the cursor to TESTS.
. Press 0 for 2-SampTInt.
. Move the cursor to Data and press ENTER.
. Type in the appropriate values.

. On the line for Pooled, move the cursor to No (standard deviations are assumed not equal)
and press ENTER.

7. Move the cursor to Calculate and press ENTER.

A N A W N

Confidence Interval for the Difference Between
Two Means and f Distribution (Statistics)

1. Press STAT and move the cursor to TESTS.

2. Press 0 for 2-SampTInt.
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. Move the cursor to Stats and press ENTER.
. Type in the appropriate values.

. On the line for Pooled, move the cursor to No (standard deviations are assumed not equal)

and press ENTER.

. Move the cursor to Calculate and press ENTER.

Excel
Step by Step

Two-Sample t Test in Excel

Testing the Difference Between Two Means:
Independent Samples

Excel has a two-sample ¢ test included in the Data Analysis Add-in. The following example
shows how to perform a ¢ test for the difference between two means.

Example XL9-2
o Test the claim that there is no difference between population means based on these

AW -

@ I N W

sample data. Assume the population variances are not equal. Use @ = 0.05.

SetA | 32 38 37 36 36 34 39 36 37 42
SetB | 30 36 35 36 31 34 37 33 32

. Enter the 10-number data set A into column A.

. Enter the 9-number data set B into column B.

. Select the Data tab from the toolbar. Then select Data Analysis.

. In the Data Analysis box, under Analysis Tools select t-test: Two-Sample Assuming

Unequal Variances, and click [OK].

. In Input, type in the Variable 1 Range: A1:A10 and the Variable 2 Range: B1:B9.
. Type 0 for the Hypothesized Mean Difference.

. Type 0.05 for Alpha.

. In Output options, type D9 for the Output Range, then click [OK].

Inpuk -

Yariable 1 Range: $ab1i48510 -
Vatiahle 2 Rargs: 484119843 53]
Hypothesized Mean Difference: o |
[ Labels

alpha; 0,05

Cutput opkions

@ Qutput lRange: _D?| E“}
) Mew Workshest Ply: l

) Mew Warkbook,

&

t-Test: Two-Sample Assuming Unegual Variances

o
Variablel  Varigble 2
Mean 36.7 33.77777778
Variance 7.344444444  5,944444444
Observations 10 g
Hypothesized Mean Difference 0
df 17
tS5tat 2474205364
P(T<=t) one-tail 0.012095
t Critical one-tail 1.739606716
P(T==t) two-tail 0.024185593
t Critical two-tail 2.109815559
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Objective [E}]
Test the difference
between two means
for dependent
samples.

9-22

Note: You may need to increase the column width to see all the results. To do this:
1. Highlight the columns D, E, and F.
2. Select Format>AutoFit Column Width.

The output reports both one- and two-tailed P-values.

Testing the Difference Between Two Means:
Dependent Samples

In Section 9-2, the ¢ test was used to compare two sample means when the samples were
independent. In this section, a different version of the ¢ test is explained. This version is
used when the samples are dependent. Samples are considered to be dependent samples
when the subjects are paired or matched in some way.

For example, suppose a medical researcher wants to see whether a drug will affect
the reaction time of its users. To test this hypothesis, the researcher must pretest the
subjects in the sample first. That is, they are given a test to ascertain their normal reaction
times. Then after taking the drug, the subjects are tested again, using a posttest. Finally, the
means of the two tests are compared to see whether there is a difference. Since the same
subjects are used in both cases, the samples are related; subjects scoring high on the pretest
will generally score high on the posttest, even after consuming the drug. Likewise, those
scoring lower on the pretest will tend to score lower on the posttest. To take this effect into
account, the researcher employs a 7 test, using the differences between the pretest values
and the posttest values. Thus only the gain or loss in values is compared.

Here are some other examples of dependent samples. A researcher may want to
design an SAT preparation course to help students raise their test scores the second time
they take the SAT. Hence, the differences between the two exams are compared. A med-
ical specialist may want to see whether a new counseling program will help subjects lose
weight. Therefore, the preweights of the subjects will be compared with the postweights.

Besides samples in which the same subjects are used in a pre-post situation, there are
other cases where the samples are considered dependent. For example, students might
be matched or paired according to some variable that is pertinent to the study; then one
student is assigned to one group, and the other student is assigned to a second group. For
instance, in a study involving learning, students can be selected and paired according to
their IQs. That is, two students with the same 1Q will be paired. Then one will be assigned
to one sample group (which might receive instruction by computers), and the other stu-
dent will be assigned to another sample group (which might receive instruction by the
lecture discussion method). These assignments will be done randomly. Since a student’s
IQ is important to learning, it is a variable that should be controlled. By matching sub-
jects on IQ, the researcher can eliminate the variable’s influence, for the most part.
Matching, then, helps to reduce type II error by eliminating extraneous variables.

Two notes of caution should be mentioned. First, when subjects are matched according
to one variable, the matching process does not eliminate the influence of other variables.
Matching students according to IQ does not account for their mathematical ability or their
familiarity with computers. Since not all variables influencing a study can be controlled, it
is up to the researcher to determine which variables should be used in matching. Second,
when the same subjects are used for a pre-post study, sometimes the knowledge that they
are participating in a study can influence the results. For example, if people are placed in a
special program, they may be more highly motivated to succeed simply because they have
been selected to participate; the program itself may have little effect on their success.

When the samples are dependent, a special 7 test for dependent means is used. This
test employs the difference in values of the matched pairs. The hypotheses are as follows:

Two-tailed Left-tailed Right-tailed
Hy:pup =0 Hy: pp =0 Hy:pp =0
Hy:p,#0 Hi:p,<0 Hi:pp,>0
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where w,, is the symbol for the expected mean of the difference of the matched pairs. The
general procedure for finding the test value involves several steps.
First, find the differences of the values of the pairs of data.

D=X —X,
Second, find the mean D of the differences, using the formula
p-2D
n

where n is the number of data pairs. Third, find the standard deviation s, of the differ-
ences, using the formula

_ [nZD* = (ED)?
b = nln—1)

Fourth, find the estimated standard error s; of the differences, which is
s
55 =—2
\Vn

Finally, find the test value, using the formula

(=P ihdf = -1

NG
The formula in the final step follows the basic format of

(observed value) — (expected value)
standard error

Test value =

where the observed value is the mean of the differences. The expected value w,, is zero if
the hypothesis is u;, = 0. The standard error of the difference is the standard deviation of
the difference, divided by the square root of the sample size. Both populations must be
normally or approximately normally distributed. Example 9-6 illustrates the hypothesis-
testing procedure in detail.

Assumptions for the t Test for Two Means When the Samples

Are Dependent

1. The sample or samples are random.
2. The sample data are dependent.

3. When the sample size or sample sizes are less than 30, the population or populations must
be normally or approximately normally distributed.

Example 9—-6 Bank Deposits

A sample of nine local banks shows their deposits (in billions of dollars) 3 years

ago and their deposits (in billions of dollars) today. At & = 0.05, can it be

concluded that the average in deposits for the banks is greater today than it was
3 years ago? Use a = 0.05.

Source: SNL Financial.

Bank 1 2 3 4 5 6 7 8 9
3 years ago 1142 841 398 737 228 1.10 1.00 09 1.35
Today 16,69 944 653 558 292 188 1.78 1.5 122

9-23



